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Preamble 
For many years I participated in the teaching of Prof. Ann Palmenberg classes, in particular 
teaching about molecular graphics on the Desktop at a time when computer use in the 
classroom was not yet preeminent. This class was a useful complement to the main topic of 
Sequence Analysis and Evolution also using computers. 
 
I personally used what was called “Unix Workstations” (Silicon Graphics, sgi) which had 
powerful graphics and rather beautiful “photorealistic” renderings. For teaching molecular 
graphics on the Desktop, I first used Rasmol, which was an amazing software fitting in 
about half of a 3.5” floppy disk or about 500 kilobytes. Rasmol included a sophisticated line 
command language but lacked the beautiful “photorealistic” renderings of the workstations. 
This was remedied by adding two other software in the course, one for the “publication 
quality renderings” (VMD) and the other for the modeling abilities of side-chain mutations 
and automated 3D superimposition of structures (Swiss PDB viewer later called DeepView.) 
 
When PyMOL was still in preliminary development at version 0.99 I spent one intense week 
porting all the class material to PyMOL. Now, rather than using three different software, all 
was possible with only PyMOL. Over the years I extended and updated the PyMOL course 
material. 
 
The UW-Madison Biochemistry students were the primary audience for these classes in 
courses Biochem 660 and 712, and occasionally in Biochem 511. I offered the PyMOL class 
in Biochem 660 for over a decade. The PyMOL tutorial and preliminary molecular graphics 
and file format introduction were part of a very large, made-to-order physical copy of a class 
book of about 500 pages that also contained tutorials on using other software. The PyMOL 
section was about 200 pages. 
 
2017 was the last year that Biochem 660 was offered. I have therefore decided to release the 
complete PyMOL tutorial which you will find split in multiple PDF files. In this final 
revision, I had updated all web pages, and added links to archived pages when web site were 
defunct to keep the text as relevant as possible for future use. 
 
I hope that it will be useful to you in accomplishing your molecular graphics goals. 
 
Sincerely, 
 
Jean-Yves Sgro, Ph.D. 
Distinguished Scientist | Senior Scientist 
Biotechnology Center      | Biochemistry Department 
University of Wisconsin-Madison - USA 
Email: jsgro@wisc.edu 
Formerly at the Institute for Molecular Virology and VirusWorld web site creator. 
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PyMOL Overview 
11.. PPrreeffaaccee  

PyMOL was created in an efficient and pragmatic manner, with 
heavy emphasis on delivering powerful features to end-users. […] PyMOL is 
about getting the job done now, as fast as possible, by whatever means were 
available. [User’s guide preface.]1 
 
PyMOL has become a de facto standard in publications containing molecular graph-
ic figures.  
 
According to the official web site www.pymol.org PyMOL can read 30 different 
file formats and offers more than 600 settings and 20 representations to provide 
users with precise and powerful control. 
 

                                                
1 http://pymol.sourceforge.net/newman/userman.pdf or 
http://pymol.sourceforge.net/newman/user/toc.html 
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“Using PyMOL, data can be represent-
ed in nearly 20 different ways.  
 
Spheres provides a CPK-like view, sur-
face and mesh provide more volumet-
ric views, lines and sticks put the em-
phasis on bond connectivity, and rib-
bon and cartoon are popular represen-
tations for identifying secondary struc-
ture and topology.” 
(Scene from menu: Wizard > Demo > Rep-
resentations) 

 

Go further with the web 
 
PyMOL: An Open-Source Molecular Graphics Tool, Warren L. DeLano, Ph.D.  

http://www.ccp4.ac.uk/newsletters/newsletter40/11_pymol.html 
[http://bit.ly/MfELjP ] [archived: http://bit.ly/2c1yJJu] 

 
Video: Understanding the PyMOL User Interface  (3:15 min) (split interface) 

http://youtu.be/vROwrMqX-0Q 
 
Video: PyMOL (SBGrid presentation) (43:03min) (includes volume rendering) 

http://youtu.be/UHOUFJmj_fM 
 
Quick Tutorials: (underlined = archived version for defunct links) 

•• http://www.pymolwiki.org/index.php/Practical_Pymol_for_Beginners 
•• http://www.carlyhuitema.com/pymol_tutorial.html   (2002/2010 – Carly 

Huitema) [defunct but available at Archive.org:  http://bit.ly/1tXrJ3x ] 
•• http://www.bio.ph.ic.ac.uk/~scurry/pdfs/PyMOL_tutorial.pdf 

archived http://bit.ly/1qzZYII (2009 –Stephen Curry) 
•• http://www.bio.ph.ic.ac.uk/~scurry/pdfs/PyMOL_movies.pdf 

archived http://bit.ly/1BdrWQC (2009–Stephen Curry) 
•• http://www.psb-grenoble.eu/IMG/pdf/pymol_tutorial.pdf (2010 – Manjasetty, 

Dian & Quintero Bernabeu) - archived: http://bit.ly/1OoLtYi 
 
 
Web Resource for users 
 
PyMOL Wiki: http://www.pymolwiki.org/ 
 
The Mail Archive: 
 http://www.mail-archive.com/pymol-users@lists.sourceforge.net/  

[ http://bit.ly/NeM6lq ] 
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Posting to Forum/Archive: 
 http://www.mail-archive.com/pymol-users@lists.sourceforge.net/info.html 

[ http://bit.ly/RYteKw ] 
 
Alternate Archive: 
 http://sourceforge.net/mailarchive/forum.php?forum_name=pymol-users 

[ http://bit.ly/M18kKc ] 
 
PDB + PyMOL Tutorial from UNC - Video (YouTube Playlist): 
 https://www.youtube.com/watch?v=bHXJgE_alF8&list=PLr_d6VlHdTSNdv8qtiWDHJnBdBervg_Eo 

[http://bit.ly/1vBECkQ ] 
 

22.. PPyyMMOOLL  iinntteerrffaaccee  
 
WITH ONLY MINOR differences PyMOL works in the same way on all supported 
platforms for both the Graphical User Interface (GUI) and the command line. 

22..11 PPyyMMOOLL  GGrraapphhiiccaall  IInntteerrffaaccee  ((GGUUII))  
 
THE PyMOL INTERFACE is split between an Upper Control Window and a lower 
Viewer Window; they appear as 2 separate windows (Windows/Linux) or a single, 
combined window (Mac, as illustrated below.) 
 

 

Upper Control Window 
with quick menu but-
tons and a command 
line that accepts pasted 
text and can be copied 
from. 
 
Lower Viewer Window 
is split into functional 
sections: 
 
- 3D view display (640 x 
480 default size.) 
 
- Names Panel: each file 
opened will have an en-
try. 
 

 

Upper Control Window 

Command Line 2!

Command Line 1!

Movie 
Controls!
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- ASHLC (Action, Show, Hide, Label and Color) menus apply independently to 
each name entry, or to all with the “all” top entry. 
-  Mouse Controls: a reminder of the functions for each button.  
- Movie Controls: VCR style button controls for animations. 
- Command Line 2:  commands are accepted here too. 
 
Note: The software menus appear at the top of the screen (Mac) or at the top of the 
separate Upper Control Window (Win/Lin) and offer amongst others the familiar 
File and Edit menus present on all Macintosh software since 1984. 
 

 
 

22..22 MMoouussee  CCoonnttrroollss  oovveerrvviieeww  
 
PyMOL SUPPORTS MULTIPLE MOUSE TYPES and track-pads. At launch the de-
fault is set to a 3-button mouse, selecting the multiple atoms of a residue when 
clicking on any of its atoms within the 3D view panel. The default functions can be 
changed with the mouse menu and the current setting is reflecting within the 
Mouse Controls sections at the bottom right. 
 

 

 

 

 
Mouse menu items 

Mouse Controls, bottom right. 
Buttons are labled as L(eft), M(iddle) ,R(ight) and 

Wheel 
 

 

Modern mouse devices have 
7 buttons 
 
    1 Click 
    2 Middle Click 
    3 Right Click 
    4 Scroll Up (considered 

 
It is relatively easy to ignore but-
tons 6 and 7.  
 
The actions performed when 
clicking on button 2 (Middle 
button) would be different than 
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button 4) 
    5 Scroll Down (consid-
ered button 5) 
    6 Back button 
    7 Forward button 

if the button is scrolled if a wheel 
is present.   

 

 

Within the PyMOL viewer, 
represented here as a black 
rectangle, the movements 
of the mouse are interpret-
ed as that of a virtual 
trackball:  
• when the mouse (shown 
as a white arrow below) is 
ON the displayed mole-
cule, the molecule can ro-
tate freely in all directions.  

 
• when the mouse is clicked OUTSIDE of the rotation “sphere”, e.g. on the top left 
area as shown, the rotation is limited to around the Z axis, which points outward 
from the screen. 
 
Clipping planes are useful to focus on specific part of large molecules. Scrolling the 
wheel can make part of the molecule disappear. Exercises will help better under-
stand this concept. 
 

Go further with the web 
 
Getting Started with Mouse Controls: 
 http://PyMOL.sourceforge.net/newman/user/S0200start.html 

[ http://bit.ly/MklUKD ] [archived: http://bit.ly/2fDU8Lm] 
 
 

22..33 MMoovviiee  CCoonnttrroollss,,  SSeeqquueennccee  DDiissppllaayy  aanndd  FFuullll  SSccrreeeenn  
 
THE VCR-like Movie Controls panel appears at the very bottom-right of the screen 
and controls the animation of displayed models.  
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The last three buttons on the right have the following meaning: 
- S: display the structure sequence (will appear as a line at the top of the 3D 

viewer) 
- Downward Triangle: rock the molecule back and forth 
- F: switch to full-screen mode 

 

22..44   LLiinnee  CCoommmmaannddss  aanndd  SSccrriippttss  
 
PyMOL ACCEPTS TEXT COMMANDS typed on the upper or lower command-
line areas or pasted within the top command-line area (see GUI figure above.)  
 

- Commands are case sensitive, but all commands are currently written with-
in PyMOL as lower-case. Therefore all commands should be written as 
lower-case. 

- As of this writing there are 191 commands listed within the PyMOL Wiki2. 
- Point-and-click (mouse) menu options typically have a line-command 

equivalent. 
- Scripts: all commands can be summarized line-by-line within a text file and 

run all at once.  
 
While learning line commands and scripting them do take time, this is part of the 
“user power” afforded by PyMOL for recording, reproducing and sharing images 
in the form of scripts. 
 

22..44..11 RReeccoorrddiinngg  CCoommmmaannddss::  LLoogg  FFiilleess  
 
All the commands, typed or clicked, can be recorded in a log file for later replay. 
For good practice the file name extension should be .pml.  
 

 

SYNTAX 
    
   log_open log-file-name 
          
EXAMPLE 
    
   PyMOL> log_open log1.pml  

Point-and-click method Command-line method 
 

                                                
2 http://www.pymolwiki.org/index.php/Category:Commands 
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To stop recording use menu “File > Close Log” or type log_close in the command 
line area. If you don't close before you exit PyMOL, your log-file will still be saved 
to disk. 
 
Later the file can be run with the menu “File > Run…” or from the command line 
by adding the symbol @ with no space as a prefix. Example: PyMOL> 
@log1.pml 
 

22..44..22 HHeellpp  
 
To see the list of available commands with help entries type help (and press re-
turn) within either of command line areas. There are about 80 commands with de-
scriptive help and examples. 
 
SYNTAX    
   help keyword 
       
EXAMPLE 
   PyMOL> help load 
 

22..44..33 LLooaaddiinngg  DDaattaa  
 
PyMOL can read and automatically recognize data format from the filename exten-
sion, which can be overridden with the appropriate line command. PDB files with 
extension .pdb will be commonly used in class and other formats will not be ex-
plored. 
 
Atomic coordinates in PDB format can be read into PyMOL from a file present on 
the hard drive with the load command or with the “File > Open...” point-and-
click menu. 
By default the root name (without .pdb) of the file will become the object name as 
a line entry within the Names & Manu Panel for further GUI manipulations. How-
ever, one can specify a chosen name if the file is opened by line-command. # is the 
comment character. 
 
SYNTAX 
    
   load data-file-name, object-name  
       
EXAMPLES 
 
   PyMOL> load pept.pdb        # The object is named "pept"  
   PyMOL> load pept.pdb, test  # The object is named "test". 
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PyMOL will read files from the HOME directory specific to the operating system 
used. Alternatively the working directory can be changed, or a path to the file into 
another directory can be specified e.g. with the cd line command. 
 
It might be advantageous or efficient to read the data directly from the Internet 
with the line-command fetch. Furthermore the fetch command can be used to 
download the biological unit instead simply by adding the qualifier type and 
specifying the biological unit desired such as type=pdb1, type=pdb2 etc. An al-
ternate object name is only allowed if downloading the original data. 
 
SYNTAX 

fetch PDB-code, type=[pdb1,pdb2,...] 
       
EXAMPLES 

PyMOL> fetch 1DUD, myTest      # The object is named "myTest 1/1"  
PyMOL> fetch 1DUD, type=pdb1   # The object is named "1DUD   1/3" 

 
Biological units are encoded as separate “models” within the PDB file but are 
called “states” once read into PyMOL. The Names Panel entry reflects the number 
of models in the file. Models represent the same atomic coordinates in a series of 
alternate configurations and are numbered consecutively. Such files result from 
NMR experiments, molecular dynamics calculations, animation or morphing soft-
ware, or due to the multimeric nature of the structure(s) such as virus capsids. By 
default only the first model/state is shown in the 3D viewer. To see all models the 
user has 2 options: show all models at once, or split the models into independent 
entry copies listed separately on the Names Panel. While these could be considered 
“advanced” commands they are essential for biologists. 
 
Showing all models at once is an on/off switch setting: 
 
SYNTAX 

set all_states, on        
set all_states, off 

 
There will be no change in the Names Panel and all models would move together 
when rotating the mouse. 
 
When making a copy of the individual models into separate object-names the orig-
inal entry remains present and can be later deleted or hidden. The new copies will 
be numbered object-name_001, _002, etc.  
 
SYNTAX 
 split_states object-name 
       
EXAMPLE 

PyMOL> fetch 1DUD, type=pdb1 # The object is named "1DUD   1/3" 
PyMOL> split_states 1DUD # split 1DUD into 3 new entries 
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     # numbered 1DUD_001, 1DUD_002, etc.  
PyMOL> delete 1DUD  # delete the original fetched entry 
PyMOL> delete 1DUD_*  # delete all separate entries 

 
Note: the delete command is useful for large units such as viruses that would 
typically yield 60 separate new entries. 
 

22..44..44 AAttoomm  SSeelleeccttiioonn::  PPyyMMOOLL  SSeelleeccttoorrss  
 
Atom selections can be made and saved within an object-name listed on the Names 
Panel. To distinguish these entries form PyMOL keywords a good practice is to 
start these names with “My” as a way to remember that these are our “creations.” 
 
The syntax format is: “select MyName = criteria” to create a new object named 
“MyName” from criteria created with a selection method with the help of one or 
more “selector” listed in the following table. 
 
Matching Prop-

erty Selector Identifier and example 

 
symbol 

chemical-symbol-list 
list of 1- or 2-letter chemical symols from the periodic table 

PyMOL> select Mypolars , symbol o+n 
 

name 
atom-name-list 

list of up to 4-letter codes for atoms in proteins or nucleic acids 
PyMOL> select Mycarbons , name ca+cb+cg+cd 

 
resn 

 

residue-name-list 
list of 3-letter codes for amino acids 

PyMOL> select Myaas , resn asp+glu+asn+gln 
 
list of up to 2-letter codes for nucleic acids 

PyMOL> select Mybases , resn a+g 
 
 

 
 

resi 
 

residue-identifier-list 
list of up to 4-digit residue numbers 

PyMOL> select Myresidues , resi 1+2+20+8590 
 
Residue-identifier-range 
PyMOL> select MyNterm , resi 1-25 

 
chain 

chain-identifier-list 
list of single letter (rarely numbers) of the chain 

PyMOL> select MyChain , chain a 
 

ss 
Secondary-structure-type 

list of single letters  
PyMOL> select Myalphas , ss hs+l+”” 
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Single Word 
Selector 

Short Form 
Selector Description and examples 

all * 
All atoms currently loaded into PyMOL 
PyMOL> color blue , all 
PyMOL> color blue , * 

none none No atoms (empty selection) 

hydro h. 
All hydrogen atoms currently loaded into PyMOL 
PyMOL> hide hydro 
PyMOL> hide h. 

hetatm het 
All atoms loaded from Protein Data Bank HETATM records 
PyMOL> show spheres, hetatm  
PyMOL> show spheres, het  

visible v. All atoms in enabled objects with at least one visible repre-
sentation 

polymer  All atoms on the polymer (not het). 

present pr. All atoms with defined coordinates in the current state (used 
in creating movies) 

 

Go further with the web 
 
Getting Started with Commands: 
 http://PyMOL.sourceforge.net/newman/user/S0210start_cmds.html  

[ http://bit.ly/N2WeBW ]   [archived:  http://bit.ly/2clELW6 ]  
Command Syntax & Atom Selections: 
 http://PyMOL.sourceforge.net/newman/user/S0220commands.html  

[ http://bit.ly/Mncc6y ]       [archived: http://bit.ly/2c4WvTE ] 
Property Selectors: 
 http://www.pymolwiki.org/index.php/Property_Selectors  

[ http://bit.ly/NrlkVp ]        [archived: http://bit.ly/2cpZO8w ] 
Single word selectors: 
 http://wwww.pymolwiki.org/index.php/Single-word_Selectors 

[ http://bit.ly/Nk2u4b ]       [archived: http://bit.ly/2c1GdME ] 
 
 

22..55 SSeettttiinnggss  
 
THERE ARE CURRENTLY 604 settings that can modify the behavior of PyMOL, 
193 of them are documented within the PyMOL Wiki (references in “Go further” 
box below.) For example there are 50 settings for ray-tracing, 58 for cartoon repre-
sentations, 29 for surface etc. A few settings can be changed by mouse within the 
main “Setting” menu.  
 
Other settings can be changed by 2 methods:  
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- the set command  
- opening a window listing settings: “Setting > Edit All…”  

 
Using the line command implies knowing the exact setting name, for example 
all_sates as seen above. The window listing affords browsing and sometimes 
guessing what the setting could be. 
 
 

Go further with the web 
 
All Settings: http://www.pymolwiki.org/index.php/Settings  

[ http://bit.ly/MnKoME ]       [archived: http://bit.ly/2cy6xkc ] 
 

Documented Settings: 
 http://www.pymolwiki.org/index.php/Category:Settings 

[ http://bit.ly/LMqIbP ]          [archived: http://bit.ly/2bVLYfZ ] 
 

Gallery of complex images calling on many settings: 
 http://www.pymolwiki.org/index.php/Gallery 

[ http://bit.ly/MnNC5n ]        [archived: http://bit.ly/2bVM2we ] 
 

 

gh 
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Installing PyMOL  
 
omputer-generated color images are illustrating numerous magazine covers 
and research articles. Creating 3D representations of molecules is much easi-
er in the 21rst Century than even in the last decade of the 20th Century when 
these could only be created on (very) expensive workstations. 
 

PyMOL is a de facto standard in scientific publications containing mo-
lecular graphic figures.  The laboratory tutorials appearing in this lab 
book are self-paced tutorials to understand how to visualize and an-
imate molecular structures in publication-quality graphics and ani-

mations for research papers and conference slide shows. 
 

 
 
PyMOL is installed on the classroom computers and is the standard molecular 
graphic software used in the Biochemistry department. 
 
 
PyMOL download on UW-Campus ? 
 
UW Students, Faculty and Staff can download PyMOL from the Campus 
Software Library (software.wisc.edu) licensed by the University of 
Wisconsin-Madison for installation on both UW-owned devices and 
personally-owned devices. 
 
(Note: NetID login required) 
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SBGrid 
 
Students in labs that access SBGrid in Biochemistry can launch PyMOL from 
an SBGrid line-command with simply the command line: pymol & 
Install SBGrid from https://biochem.wisc.edu/intranet/it/sbgrid 
 

 
If you are not affiliated with UW here is some useful information about acquiring 
PyMOL: 
 
For your personal use, Teachers and Students can request an educational license of 
PyMOL from the following web page request: 
http://pymol.org/educational/ 
 

“PyMOL values scientific progress and understands the opportunity cost 
that can accompany the pursuit of education.  As such, PyMOL offers Edu-
cational-use-only PyMOL builds available at no cost to teachers and full-
time students for classroom instruction, homework assignments, and to 
provide students with means for creating professional-grade figures and an-
imations for posters, talks, publications, and dissertations.” 

 
Note: Other free options exist, but require some computer administration: 
 

Precompiled versions for the Windows operating system available at 
http://www.pymolwiki.org/index.php/Windows_Install 
[archived: http://bit.ly/2bQMNDr ] 
 
With Mac Port (http://www.macports.org/) Macintosh users can in-
stall from source code after other requirements have been fulfilled (such as 
installing Apple’s Xcode) with command: port install pymol 
 
Another option for Mac users with the same prior requirements is to use 
homebrew (http://brew.sh) with the command:  
brew install homebrew/science/pymol 
 
Linux users can also install from source code with e.g.  

sudo yum install pymol 
 or  sudo apt-get install pymol 

 
 
Tutorials for other molecular graphics software for UW classes are available as PDF 
online http://www.virology.wisc.edu/acp/Classes/tutorials.html 
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These tutorials were previously used in class before or concurrently with PyMOL: 
 

- VMD is another free software for creating rendered molecular surfaces 
and ribbon diagrams and has a method for the automatic generation of ani-
mated movies. 
 
- DeepView (formely Swiss PDB Viewer) was used for mutating an amino-
acid side chain and is also useful to superimpose related structure in three 
dimensions. 
 
- Rasmol is a simple 3D visualizer with a scriptable line command for creat-
ing animations. Rasmol provides the basis for quick analyses and can export 
scripts for other rendering software. Rasmol can be used for creating 3D ob-
jects with the Z-print printer as well. Rasmol is free and runs on virtually 
any platform. Jmol now is used as the Rasmol web plug-in equivalent and 
offers many of the Rasmol options and line commands. 

 

gh 
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Before we start with 
PyMOL – 2biw – 
carotenoid oxygenase 
11.. CCaarrootteennooiidd  ooxxyyggeennaassee  eennzzyymmee  
 
THE EXERCISES IN THE NEXT SECTION concentrate on learning the PyMOL 
software using a protein example for many exercises. Here is some information 
about this protein that may be useful: 
 

2biw Description 
 
Enzyme function 
description 3 

Carotenoid oxygenase breaks carotenoids (the colorful pig-
ments in carrots) in half, forming vitamin A (retinal). This 
structure includes the enzyme, a carotenoid molecule, and 
an iron ion that positions oxygen for the cleavage reaction. 

PDB ID number 2biw or 2BIW 
Related structure 2BIX (Fe, Free apoenzyme) 
 
Primary citation 

Kloer DP, Ruch S, Al-Babili S, Beyer P, Schulz GE.  
The structure of a retinal-forming carotenoid oxygenase.  
Science. 2005 Apr 8; 308(5719):267-9. - DOI: 
10.1126/science.1108965 

Abstract: Enzymes that produce retinal and related apocarotenoids constitute a sequence- and thus 
structure-related family, a member of which was analyzed by x-ray diffraction. This member is an ox-
ygenase and contains an Fe2+-4-His arrangement at the axis of a seven-bladed beta-propeller chain 
fold covered by a dome formed by six large loops. The Fe2+ is accessible through a long nonpolar tun-
nel that holds a carotenoid derivative in one of the crystals. On binding, three consecutive double 
bonds of this carotenoid changed from a straight all-trans to a cranked cis-trans-cis conformation. The 
remaining trans bond is located at the dioxygen-ligated Fe2+ and cleaved by oxygen. 
                                                
3 Verbatim from PDB 101 molecule of the month (http://bit.ly/qRqNTc ) 
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11..11 PPrrootteeiinn  ffoolldd::  sseevveenn--bbllaaddeedd  ßß  pprrooppeelllleerr  
 

 

  
PyMOL cartoon representation in 
similar orientation 

Figure S3 (supplemental material), Kloer et 
al. Science paper  

11..22 RReeaaccttiioonn  
 
THE REACTION IS DESCRIBED in the Kloer et al. Science paper. ACO is short for 
“apocarotenoid-15,15’-oxygenase” 
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11..33 PPoocckkeett  
 
THE PROTEIN WAS CRYSTALLIZED with a retinoic compound that lies within a 
pocket inside the enzyme as illustrated with the following PyMOL-generated im-
ages: 
 

  

 

 

 

 

 
The retinoic compound is labeled “organic” in the illustration and within the PDB 
file structure the retinol is named: (3R)-3-hydroxy-8'-apocarotenol and abbreviated 
3ON. 
 
In addition there is an iron atom Fe2 (see illustration below.) 
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11..44 LLiiggaanndd  iinntteerraaccttiioonnss  
 
SOME WATER MOLECULES MAY SOMETIMES PLAY AN IMPORTANT ROLE 
in the activity of an enzyme. In the case of this protein, two of them are near the 
position where oxygen is used to cleave the retinol compound. The iron atom (Fe) 
is held in place by the grip of 4 histidine amino acid side chains.  Between the iron 
sphere and the retinoic compound are 2 oxygen atoms representing water mole-
cules.  
 
Water molecules residues number 
2022 and 2079 and iron (Fe) residue 
number 1492 within the PDB file. 
 
Histidine residues sequence num-
ber: 183, 238, 304, 484 
  

22.. MMeemmbbrraannee--bboouunndd  
 
IN THEIR SCIENCE PAPER Kloer et al. propose that “The surface of ACO contains a 
nonpolar patch that consists mostly of protruding leucines and phenylalanines (Fig. 3A). 
We propose that ACO uses this patch to dip into the membrane and extract its nonpolar 
substrate from there.” 
 
The link to the web site is:  
 http://opm.phar.umich.edu/protein.php?search=2biw 
 [ http://bit.ly/Y99eh1 ] 
 
The web site “orientations of proteins in mem-
branes” (OPM) offers a set of PDB format co-
ordinates with “DUM” atom entries represent-
ing the cytoplasmic side of the membrane 
boundary.  
 
The coordinates can be downloaded as a PDB 
text file or viewed with accessory plug-in 
software webmol or Jmol. 
 
Shown here is the representation resulting 
from choosing Jmol. 
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33.. OOppttiioonnaall  pprreelliimmiinnaarryy  eexxeerrcciissee  
 
Exploring the 3D data file content: 
 
You can display the coordinates of the 2BIW structure by going to the PDB database web 
site http://www.rcsb.org 
 
 
Enter 2BIW in the search area. 
 
Next to the large 2BIW on the right hand side choose “Display Files > PDB File” 
 
Scroll up and down the text file and observe the contents.  
 
H 
 
E 
 
A 
 
D 
 
E 
 
R 
 
 
 
3 
D 
- 
D 
A 
T 
A 
 
 
E 
N 
D 

HEADER    OXIDOREDUCTASE                          19-JAN-05   2BIW               
TITLE     CRYSTAL STRUCTURE OF APOCAROTENOID CLEAVAGE OXYGENASE FROM             
TITLE    2 SYNECHOCYSTIS, NATIVE ENZYME                                          
COMPND    APOCAROTENOID-CLEAVING OXYGENASE                                       
KEYWDS    OXYGENASE,NON-HEME IRON,CAROTENOID CLEAVAGE,RETINAL                    
KEYWDS   2 FORMATION, OXIDOREDUCTASE, DIOXYGENASE                                
EXPDTA    X-RAY DIFFRACTION                                                      
AUTHOR    D.P.KLOER, S.RUCH, S.AL-BABILI, P.BEYER, G.E.SCHULZ                    
JRNL        AUTH   D.P.KLOER, S.RUCH, S.AL-BABILI, P.BEYER, G.E.SCHULZ           
JRNL        TITL   THE STRUCTURE OF A RETINAL-FORMING CAROTENOID                 
JRNL        TITL 2 OXYGENASE                                                     
JRNL        REF    SCIENCE                       V. 308   267 2005               
JRNL        REFN   ASTM SCIEAS  US ISSN 0036-8075                                
REMARK   1                                                                       
SEQRES   1 A  490  MET VAL THR SER PRO PRO THR SER SER PRO SER GLN ARG           
SEQRES   2 A  490  SER TYR SER PRO GLN ASP TRP LEU ARG GLY TYR GLN SER     
[. . . . . . . . . . . . ] 
MTRIX2   3 -0.756169  0.514705 -0.404088       13.98510    1                     
MTRIX3   3  0.610627  0.777006 -0.152957      118.86930    1                     
ATOM      1  N   GLN B  12      16.794 -17.939  28.900  1.00 71.25           N   
ATOM      2  CA  GLN B  12      16.091 -17.967  30.218  1.00 71.00           C   
ATOM      3  C   GLN B  12      16.877 -17.181  31.273  1.00 69.76           C   
[. . . . . . . . . . . . ] 
ATOM   3766  CG2 THR B 490      47.002  -0.207  59.451  1.00 73.42           C   
ATOM   3767  O'' THR B 490      48.633   0.228  56.341  1.00 73.10           O   
TER    3768      THR B 490                                                       
HETATM 3769 FE    FE B1492      30.259   6.403  38.822  1.00 45.64          FE   
HETATM 3770  O1  3ON B1491      26.391  21.062  36.210  1.00100.47           O   
HETATM 3771  C5  3ON B1491      25.099  20.591  36.637  1.00100.23           C   
[. . . . . . . . . . . . ] 
CONECT 3799 3798                                                                 
CONECT 3800 3798 3801                                                            
CONECT 3801 3800                                                                 
MASTER        0    0    0   36  154    0   24   1515742    4   37  152           
END                                                                              
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PyMOL Tutorials (1) 
 
Note: within the exercises, Bold text shows what actions are taken by the user: 
typing text or clicking the mouse. 

Whenever possible a “call for action” icon (√  or  ✔✔) will be shown: 

√ or ✔✔ TASK: you have something to do, a task to accomplish! 

 ✔✔ READ: reading this material will help understand the task at hand 

 ✔✔ INFO:  additional information that is nice and useful but not critical 

 ✔✔ Advanced: for your information only. Advanced resources are not 
  covered in these exercises and are reserved for expert users. 

 ✔✔ NEW:  New feature added in recent version(s) 
 

 
 

✔✔ FIRST TASK: Before starting please review “PyMOL Overview” in the pre-
vious section as a refresher from the slide presentation. Hints will be given along 
the way as well, and you can raise your hand if you have a question! 

gh 
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11.. OOppeenn  PPyyMMOOLL  aanndd  llooaadd  ccoooorrddiinnaatteess  
 
 
Reminder: Structures are published with a PDB ID code of 4 characters. PDB files 
are plain text and contain coordinates pertinent to the crystallographic arrange-
ment of the molecules within the crystal. The biological functional entity can be ei-
ther a multimer of the deposited structure, or just one of multiple copies within the 
file. In the following example we will obtain one functional biological subunit, in 
this case a monomer, directly from the Internet. We will specify which of the mon-
omer we want with the use of the qualifier type= and specifying “2” will mean 
that out of the 4 existing monomers making the crystal we want the 2nd one. 
 
 

 

 
PyMOL (or MacPyMOL) should be located within the Applications 
folder on the Macintosh computer.  
Your instructor may give you a different location if necessary. 
 

✔✔ TASK: double-click on the icon for PyMOL (or MacPyMOL) to launch the 
software.  
 
After the PyMOL> prompt within the top line command, type the following 
command:  
 

✔✔ TASK:   fetch 2biw, type=pdb2  
 
This command will instruct PyMOL to connect to the protein data bank (PDB) over 
the Internet and obtain the 2nd monomer from the original 3D (which contains 4 
monomers in total, accessible as type pdb1, pdb3 and pdb4.) 
 
The coordinates are downloaded and read into PyMOL (they are also saved within 
the default user directory.) 
Under the Names Panel at right note the new entry: 2biw 1/1 
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Note: if the molecule moves back and forth you can stop the movement simply by 
clicking on the top right button Rock. (Here the background has been changed from the 
default black to white for clarity.) 

22.. SSaavviinngg  aa  sseessssiioonn,,  RReesseett,,  RReeiinniittiiaalliizzee  

22..11 SSeessssiioonn  ffiillee  
 
A session file is a binary file containing all the information, settings and graphical 
displays currently within PyMOL. It is a way to save the “current state”of the 
software with all that it contains. Later, the file can be opened and everything is 
restored! 
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✔ TASK From the top menu follow the 
menu cascade: 
 
File > Save Session As… 

 

 
In the next window enter a name: MySession 
and save the resulting file on the Desktop to 
easily find it again. 
 
The successful writing of the file will be re-
ported within the text window of the “Upper 
Window” and a file called Mysession.pse  
Now quit PyMOL: File > Quit 

 

 
Note: pse files are not always 100% compatible between all PyMOL version num-
bers (but should be across operating system platforms of same version.) 
 

22..22 RReessttoorriinngg  tthhee  sseessssiioonn  ffiillee  
 
While it is possible to simply double click on the MySession.pse icon, this could 
create problems if there are multiple copies or versions of PyMOL within your 
computer. It is therefore best to first open the PyMOL software version you want 
to utilize. 
 

✔ TASK double click on the Applications > MacPyMOL software to open it. 
Within the PyMOL top menu follow the menu cascade: File > Open….. 
and then select Mysession.pse from the Desktop. 
 
All the PyMOL names and selected items are restored as if you had just made 
them, even if days have passed since you saved the file. How convenient! 
 
Note: the file has a binary format. There is no information within the file that is useful for any other 
purpose. The file for this exercise should likely be slightly less than 1Mb in size. 
 

22..33 RReesseett  
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The line-command reset will simply reposition the molecule(s) in the original 
orientation without changing anything else. The background or the various cartoon 
representations will not be affected. 

22..44 RReeiinniittiiaalliizzee  
 
The top menu “File > Reinitialize” will erase everything and reset PyMOL in it’s 
default state as when it was first opened. 
 
This is useful to restart from scratch without re-launching PyMOL. 

33.. CCoommmmaanndd  GGeettPPDDBB  
 

✔✔ INFO 
 
Starting with PyMOL 2.0 the com-
mand File > GetPDB can also help 
the biological unit of a PDB file 
through a pop-up window. 
 
However, in some cases it may be 
necessary to know some prior infor-
mation. 
 
For example in the case of 2BIW, if 
we want to call for the 2nd item it is 
necessary to know that the chain ID 
name is B. Indeed in the original PDB 
the four identical biological mono-
mer making up the crystallographic 
assymetric unit are labeled A, B, C 
and D. 
 
Therefore the window to load this 
structure would look like this after 
calling the menu File > GetPDB 
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Note: the downloaded structure name would be different, in this case it would be 
2BIWB. 
 

44.. PPyyMMOOLL  ––  HHoommee  DDiirreeccttoorryy  &&  PPaatthh  
 
PyMOL will “look” by default within the “Home” directory, typically the directory 
bearing the user’s name.  
 
On the DMC Macintoshes, the HOME directory is called dmc and could also be 
written as /Users/dmc 
 
On a Windows system it would depend on the Windows version: 
 
Microsoft Windows 2000, XP and 2003, e.g. C:\Documents and Set-
tings\username 
 
Microsoft Windows Vista,  7, and 10 e.g.   C:\Users\username 
 

You should be, or become familiar with the 
operating system of your own computer. 

 
Useful commands:  
 

✔✔ TASK Type the next commands after PyMOL> within the top line com-
mand: 
 
PyMOL> cd desktop Note the echo on the text area above 
PyMOL> pwd This will echo /Users/DMC/Desktop or a similar 

path.  
 

Note: PyMOL uses many Unix-like commands (but this works in all com-
puters!) 

cd =  change directory 
pwd =  present working directory 
ls =  list files 

 
Note: cd ~/desktop (tilde and forward slash) will always take you home 
to the desktop if you are “lost” for any reason. 
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Note: If you have a PDB file on the Desktop that you want to read into PyMOL use 
either the “File > Open…” menu or the load filename line-command. 

55.. PPyyMMOOLL  iinntteerrffaaccee  ddeeffaauullttss  aanndd  sseettttiinnggss  
 
Interface basics are presented in a previous section named “PyMOL Overview.” 
When PyMOL opens a molecule for the first time all defaults are on (e.g. black 
background, molecule presented as green lines etc.) and PyMOL assumes a 3-
button mouse. All of the defaults can easily be altered with a mouse click or a 
command. 
 

55..11 DDeeffaauulltt  mmoouussee  sseettttiinnggss  aanndd  sseelleeccttiioonn  
 

Top menu bar “Mouse” options: 
 

  

 

 

✔✔ INFO – By default PyMOL as-
sumes that you have a 3-button 
mouse. 
 
If you have a 2- or one-button mouse 
you can change the setting accordingly. 

 
✔✔ READ – The Selection Mode> 
submenus define what is selected 
when one atom is clicked on. 
The selection default is Residues (i.e. 
one amino acid or one nucleotide.)  
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55..22 BBaacckkggrroouunndd  ccoolloorr  
 
Black backgrounds look very nice on the screen but do not print well on paper and 
do not photocopy well. Changing the background to white is usually very useful: 
 
The “Display” menu within the top 
menu bar contains most options perti-
nent to displaying the image within the 
PyMOL viewer.  
 

✔ TASK 
Change the background color to white 
following this menu cascade:  
 
Display > Background > White  

 
Note: alternatively type the following command: bg_color white 
 
 

55..33 AASSHHLLCC  mmeennuuss  
 

✔✔ READ PyMOL can open more than one molecule at a time, or separate com-
plex PDB data into individual components. Each one is given a name within the 
“Names Panel” on the right-hand side. The first name is always “all.” Clicking on 
the name itself will un-display the corresponding molecule(s) (rendering it tempo-
rarily invisible.) 
 
The ASHLC menus ( ) are abbreviations for Action, Show, Hide Label 
and Color. Some menu items have submenu components. Selections made under 
the “all” line will affect all listed molecules visible or not. 
 

55..33..11 SShhooww  ccaarrttoooonn,,  HHiiddee  lliinneess  aanndd  wwaatteerrss  
 

✔ TASK Let’s first make a cartoon representation of this protein: on the 2biw 
line within the “Names Panel” perform the mouse-driven changes: 
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ü click S 
ü scroll down and select cartoon.  

 
The molecule is now shown as both car-
toon and wireframe.  
 
Remove the wireframe by hiding the lines: 
 
ü click H  
ü select lines.   
 
The remaining red dots are water molecules that are part of the solved crystal 
structure. We can hide them for now with the mouse command:  

✔ TASK 
 
ü click H and  
ü select waters.  

 
Alternatively: use either of the following commands (depending on how waters are 
called within the 3D data.) 
 

hide everything, resn HOH 
 
hide everything, resn WAT 
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55..33..22 CCaarrttoooonn  ooppttiioonnss  aanndd  sseettttiinnggss  
 
Most options can be set within the “Setting” menu from the top menu bar. For ex-
ample, it is possible to change the way all alpha helices are rendered. 
 

✔ TASK Follow the menu cascade: 
  
Setting > Cartoon > Cylindrical Helices 
 
Select this option again to remove its effect  
 
Then do the following:   
 
 Setting > Cartoon > Fancy Helices  

 
Testing other cartoon settings: Engaging the option Smooth Loops will simplify 
the drawing. Removing the option Highlight Color will make the edges of strands 
and inside helices surfaces a gray color (default). 
 

✔✔ INFO –  Cartoon Options: 
  
Turning the variable cartoon_discrete_colors 
“on” makes the helix color end abruptly at the ends 
of the helix. The default value is off. The change can 
be done manually with the menu cascade Setting > 
Edit All… or can be given as a typed command:  
 
    set cartoon_discrete_colors = on  
 
(the blank space on either side of the = sign is op-
tional). 

 
Setting      
Edit All…  
 

 

 

 
 

set cartoon_discrete_colors = off set cartoon_discrete_colors = on 
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55..33..33 CChhaannggiinngg  ccoolloorr  
 

Changing the color of the ribbon is easy with 
the following cascade menu within the PyMOL 
“Names Panel” under the C menu as shown in 
the following menu cascade: 
 

✔ TASK 
 
 2biw > C > oranges > orange 
 
 
  

 
 

Alternatively: you may choose the option to 
color by secondary structure by following this 
menu cascade instead: 
 
 2biw > C > by ss > Helix Sheet Loop 
Then choose one of the proposed color options 
displayed e.g. the first option is colored red-
yellow-green. 

 

 

55..33..44 DDiissppllaayyiinngg  ((aaddddiinngg))  lliiggaanndd  
 
When we opted to show the molecule as a cartoon above, one thing happened: the 
protein was shown as the familiar cartoon representation, but we did not see that 
the ligand disappear from view; it was shown and “lost” within the many lines 
shown. Here we will “rescue” the ligand! 
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The following cascade within the Show menu for line 2biw 
will show the ligand.  

✔ TASK 
 
 2biw > S > organic > spheres  
 
This cascade will select the carotenoid present within the PDB 
file.  
 
Note that it is the same color as other parts of the protein, as it is part of the 
name 2biw line. It will be either orange or the color for loops in the 
C/ss/Helix-Sheet-Loop color scheme chosen in the step above. 

 

 
To more easily distinguish the organic (carotenoid) let’s color it gray:  
(see also “mouse selection” section on the next page.) 

ü click on any atom of the organic 
ü on the (sele) line, under 2biw, click C 
ü choose gray50.  

 
Alternatively: type the following command: color gray50, organic 

55..33..55 SSuurrffaaccee  rreepprreesseennttaattiioonn  
 
Surface representations used to be extremely computationally intensive. However, 
PyMOL offers very fast and beautifully rendered surfaces.   
 

✔ TASK 
 
Using the show (S) menu, display the surface 
of the protein, then hide it with the H menu: 
 
 2biw  > S > surface 
 
 2biw > H > surface      
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55..33..66 SSpphheerree  rreepprreesseennttaattiioonn  
 
In the same way, we can ask PyMOL to show all atoms as spheres. Note that the 
water molecules reappear as they are part of the 2biw structure and need to be 
hidden again. 
 

✔ TASK 
Using the show (S) menu, display as spheres, 
then hide spheres with the H menu: 
 
 2biw  > S > spheres 
 
 2biw > H > waters 
 
 2biw  > H > spheres 

     

 
Note that in doing so, we now loose the organic representation as sphere; we can 
add it again: 
 

  2biw > S > organic > spheres  
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Making Selections 
11.. AAttoomm  sseelleeccttiioonnss  
 
PyMOL offers a few methods for selecting atoms: 
 

- Mouse clicks 
- Command line 
- Sequence viewer 

 

11..11 MMoouussee  sseelleeccttiioonn  
 
Now that we have made the ligand visible above, it becomes easier to select it with 
the mouse to make further changes. 
 

11..11..11 SSeelleeccttiioonn  bbyy  cclliicckkiinngg  
 

✔ TASK Click on one of the spheres of the carotenoid ligand.  
 
This simple click makes various things happen:  
 

• pink, square dots appear onto all the spheres of the ligand, indicating that 
it has been selected. 
• “(sele)” appears or gets highlighted within the “Names Panel” and is now 
dedicated to this subset of atoms. Note: clicking more atoms will “add 
them” within (sele) 
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• the name of the atom that was clicked appears within the top text win-
dow. 
 
For example: 

You clicked /2biw//B/3ON`1491/O1 
Selector: selection "sele" defined with 32 atoms. 

 

✔ TASK Alter the atom color by element: 
 

(sele) > C >  by element > CHNOS….  
 
Selecting the 6th CHNOS… after  HNOS… in 
the list would display the ligand as gray with 
one red oxygen. 
  

 

11..11..22 SSeelleeccttiioonn  bbyy  ddrraaggggiinngg  
 
While holding the SHIFT key it is possible to use the left mouse to select a zone 
(an area) of atoms currently being displayed with a click and drag motion. 
 

✔TASK: You can try this on your own then click anywhere in the background 
to unselect. 
 

11..11..33 FFiinnddiinngg  aanndd  sseelleeccttiinngg  tthhee  iirroonn  

✔✔ READ   Carotenoid oxygenases trap a carotenoid molecule inside a deep 
pocket and break it into two pieces using oxygen.  
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An iron ion assists in the reaction, positioning 
the oxygen at the proper place and activating it4. 
 
At the moment, depending on your coloring and 
3D rotations, your display should look similar to 
this: 
 

- protein as ribbons 
- ligand as spheres 

 
 
If you look within the center of the molecule and 
zoom in, you may see that there is an atom that is 
only shown as a cross-star near the carotenoid 
compound.  
 
This is the iron atom. Chemical symbol: Fe  

✔ TASK Select the iron atom by clicking on the cross-star next to the carote-
noid 

ü click anywhere within the background in order to 
“empty” (sele) 

ü click on the cross-star 
 
Alternatively, type the following line command: 
 select IRON, element Fe 
 
Then, with the selected achieved either way continue to change its display mode: 

(sele) >  S > spheres 
(sele) > C >  oranges > orange 

 
 (Note: see Adam Steinberg’s hand out for default element colors in PyMOL) 

 

✔✔ INFO –  Histidines and bound waters –  
 
Some water molecules play an important role in the activity of an enzyme. In the 
case of this protein, two of them are near the position where oxygen is used to 
cleave the retinol/carotenoid/organic compound. The iron atom (Fe) is held in 
place by the grip of 4 histidine amino acid side chains.  Between the iron sphere 

                                                
4 http://www.rcsb.org/pdb/101/motm.do?momID=66      [ http://bit.ly/OAXJ50 ] [archived: http://bit.ly/2yu1yZy] 
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and the retinoic compound are 2 oxygen atoms representing water molecules.  
 
 
Water molecules residues number 2022 
and 2079 and iron (Fe) residue number 
1492 within the PDB file. 
 
Histidine residues sequence number: 
183, 238, 304, 484 
 
(See below for atom selection.) 

 

 

 

11..22 AAttoomm  sseelleeccttiioonn  bbyy  ccoommmmaanndd--lliinnee  
 
While selecting atoms with the mouse may be more intuitive and seems easier, 
there comes a time when knowing the correct command to type may be the easiest 
method for atom selection. Commands are created with PyMOL command words 
called “selectors” which are reviewed in a previous section named “Presenting 
PyMOL.” 
 

✔ TASK We will recreate the image shown within the gray box above with 
line commands. 
 

- Reminder: Lines starting with # are comments and need not be typed as 
they are ignored. Note the important use of the comma ( , ) within the 
commands.  

 
- resi means residue number 
- symbol is the chemical symbol of an atom 
- name is the atom name within the PDB data.  
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Type the following commands within the upper window after the PyMOL> 
prompt: 
 
Note: lines starting with # are comments are need not be typed. 
 

hide all 
# color by element, carbons gray 
util.cbaw 
# the organic compound 
show sticks, organic 
# the 2 water molecules 
show sphere, resi 2022+2079 
# the iron 
show sphere, symbol fe 
color orange, symbol fe 
# the histidines 
show stick, resi 183+238+304+484 
# hide the backbone atoms 
hide stick, name n+c+o 

 
 
 

 
Note: util.cbaw is a not well known command utility that means “color by at-
om” (cba) and the 4th letter means something else, here w means white/grey. See 
http://www.pymolwiki.org/index.php/Advanced_Coloring for more 
details and a list of similar commands. 

11..33 AAttoomm  sseelleeccttiioonn  bbyy  sseeqquueennccee  vviieewweerr  
 
The sequence viewer is a feature that can be engaged in 2 ways (see images below:) 
 

- by pressing the  S  button within the VCR viewer (bottom right) 
- by using the Display Menu 

 

  
 

- Pressing the S within the VCR viewer - Using the Display Menu 
 
The default view is to show the one-letter code for amino acids (Residue Codes), 
while “Residues” would show the 3-letter code.  
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✔ TASK Exercise selecting from the Sequence Viewer. 
  
Show the sequence of the protein us-
ing one of the 2 methods described 
above. 
 
Then using the scroll bar: go to the 
end of the sequence area where you 
can see the end of the protein se-
quence. 
 
 Click on His 484  
 Click on Fe 
 
Just note that the pink selection 
squares appear within the viewer. 

 

 
The numbering is aligned with the first 
digit. 
  
Therefore His-484 is either the 3rd after 
Tyrosine (Y)-481 or 2nd  before Serine 
(S)-486  

 

22.. SSeelleecctt  rreessiidduueess  ccoonnttaaccttiinngg  tthhee  lliiggaanndd  
 
The ligand sits in a pocket and we would like to select amino acids that are in con-
tact with the ligand. For this purpose we can first select the ligand and then modify 
the selection with a special “modify” menu. 
 
The make the process clearer we’ll hide everything and then display only the lig-
and before searching for the contacts: 
 

✔ TASK Hide everything: all > H > everything 
Now show only the ligand as sticks: 
 2biw  > S > organic > sticks 
 Click anywhere within the background in order to “empty” (sele) 
 Click on any atom of the ligand 
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We are now going to modify the selection to find contacting atoms (within 4 Å,) 
and at the same time select the whole amino acid that owns this atom. 
In addition, the ligand itself will be removed from the selection. 
The final selection will only contain all the atoms from all the detected amino acids. 
This is accomplished with a “modify” menu. 
Therefore the ligand serves as a method to find 
amino acids ‘around” it that are close. 
In some other cases we may want to “expand” 
the selection itself with the contacting residues. 
For this reason the “modify” menu contains mul-
tiple choices. 

✔ TASK Click on the  A  object button of 
(sele) and scroll to find the modify menu.  
 
Continue the menu cascade to select around the 
selected ligand choosing complete residues with-
in 4 Å: 
 
A > modify > around > residues within 4 A 
 

 

Since we hid everything earlier we can see the selection markers but we need to 
make the selected elements appear within the view: 
 

(sele) > S >  sticks 
Note that the ligand is no longer selected.  
 
Now color the new residues, 
for example: 
 

(sele) > C > byelement 
 
Note that some “floating 
squares” are water mole-
cules and can be shown as 
small spheres with: 

(sele) > S >  nb_sphere 
 

 
Note: the whole GUI cascade takes time and for repetitive selections a line com-
mand can be useful.  
 
The whole thing can be encapsulated in a single line command: 
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select byres 2biw within 4 of organic 
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Making, Saving Images 
Images – Ray, Transparency, Size, Saving 
 

✔ TASK Display the protein cartoon again: 
 
 2biw  > S > cartoon 

11.. RRaayy  ttrraacciinngg  
 
PyMOL offers an internal “ray tracer” to create stunning rendered images with a 
high visual quality much more pleasant to the eye and ideal for publication. 
 

✔ TASK To create a standard ray-traced image of the current Viewer scene, 
click the “Ray” button at the top right of the “Upper Window.”  
 

  
Macintosh Windows 

 
The rendering will take a few seconds to a few minutes depending on the complex-
ity of the PDB file and the chosen display, and will also depend on the speed of the 
computer CPU. Once rendered, the image appears within the Viewer.  
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To save the file, use the save cascade as above: File > Save Image As… 
 

  
Zoomed side-by-side comparison between the PyMOL image and the ray-traced image: note the 
jagginess of the original image and the smooth appearance of the ray-traced image, with shadows 
as a bonus. The effect is exaggerated here! 
 
Alternatively: the command ray can be used within the command-line area. 

22.. TTrraannssppaarreenntt  bbaacckkggrroouunndd  
 
Ray traced images support a transparent background. There are two methods to 
engage the transparent background for rendered images: 
 

- Uncheck the menu:  Display > Background > Opaque Background 
- The command line:  set ray_opaque_background, off 

 
The optional menu “Show Alpha Checker” provides a visual cue that indeed the 
background is transparent (see image at right.) 
 

 
 

Uncheck Opaque Background Alpha Checker is on by default 
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Note: the checker background is only shown after the “render” command has been 
issued. 

33.. IImmaaggee  ssiizzee  
 
Screen resolution (72 dpi – dots-per-inch) falls short of the needs for paper publica-
tion that require a minimum of 300 dpi. For example 1800 pixels would represent 6 
inches at 300 dpi. 
 
PyMOL can specify the number of pixels for ray-traced images with the ray com-
mand. The command can be given one or two numbers separated by a comma. If 
only one number is given the other will be inferred from the current display shape. 
 

✔ TASK 
 
Within the PyMOL> line com-
mand type the following com-
mand to change the dimensions 
of the final ray-traced image: 
 
 ray 1800 
  
The resulting image height will 
be inferred from the current 
display. (1177 shown here. Re-
sults will vary with window 
shape.) 

 

 
Examples for “width, height” specified: 
 

ray 1800, 1200 
ray 2000, 2000 

 

✔✔ INFO  - Ray tracing options: 
 
There are at least 50 editable settings listed in the menu Setting > Edit All… for ray 
tracing! The following 2 are of special interest: 
 
ray_shadows is “on” by default and can be switched within the settings window 
or the line command: set ray_shadows, on  or  set ray_shadows, off 
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ray_trace_mode has a default of 0 and can also adopt values of 1, 2 and 3 to cre-
ate contour-enhanced images or old-fashion black and white contours in the Jane 
Richardson style (who used to hand-draw images in the early days!) 
 

  
set ray_trace_mode, 1 set ray_trace_mode, 2 

 
To render type ray or click the “Ray” button 
 
Return to ray trace defaults: set ray_trace_mode, 0 
 
 

44.. SSaavviinngg  aann  iimmaaggee  
 
Whatever is currently displayed within the 3D viewer (whether ray-trace or dis-
played) can be saved “as is” into an image file in the PNG5 format. 

44..11 SSaavviinngg  ffrroomm  FFiillee  mmeennuu  
 
If you still see the selection dots over the ligand from the previous section simply 
click anywhere on the white background to unselect. Alternatively click on the 
“Hide-Sele” in the “Names Panel.” 

                                                
5 PNG = Portable Network Graphics, a compressed raster graphic format expected to replace the 
Graphics Interchange Format (GIF) owned by Unisys that requires licensing for software develop-
ment. 
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✔ TASK Rotate the molecule to find a perspective that you deem instructive 
of the conformation of the protein and its bound ligand. 
 
Follow this menu cascade to save the image 
currently within the Viewer: 
 
 File > Save Image As > PNG… 
 
A dialog window will appear.  
 
Replace the default word “PyMOL” to give a 
name to the file you want to save, e.g. image1 
or image1.png 
 
In this example the image will be saved as a 
PNG file on the desktop as indicated by 
“Where.” 

 

 

✔✔ INFO  - Screen Capture: 
If for any reason you cannot save the current image of your PyMOL session, the 
following info is useful to capture the screen, or a portion of the screen of your 
computer display: 
 
Macintosh Windows 
 
Full screen:   ⌘ + Shift + 3 
Screen selection: ⌘ + Shift + 4 

 
Full screen:  Print Screen key 
Screen selection: Shareware 
 

 

44..22 SSaavviinngg  aanndd  iimmaaggee  wwiitthh  ccoommmmaanndd  lliinnee  
 

✔✔ INFO    
 
The command png filename will save the image file within the current directory. 
 
SYNTAX 
     png file-name   
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EXAMPLE 
     PyMOL>  png test.png    # The file is saved by default in home dir  
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Preset menus 
Action > preset menus 
 
This is mostly a self-paced exploration of one of the menus that is sure to change 
over time as PyMOL evolves.  
 

Preliminary If you are not continuing this exercise from the previous exercise 
do the following tasks: 
√ - fetch the structure 2biw, type=pdb2 
√ - then click   S > Cartoon to be in a similar state as in the previous exercise. 

 

11.. PPrreesseettss::  aauuttoommaatteedd  ccoommpplleexx  iimmaaggiinngg  
 
The preset menu is part of the Action set of the ASHLC menus controlling the as-
pect of molecules from the “Names Panel.” 

✔✔ TASK Follow this menu cascade sequence to return to the default view, as 
when you just opened the molecule. No rotation will occurs: 
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 2biw >  A > preset > default 
 
Note: This command has a similar effect but 
is not the same as the following cascade:  
 
“hide everything and show lines:” 
 
2biw >  H > everything 
and 
2biw >  S  > lines  

 
Note: the “preset” options will set some variables that are specific to these views 
and may change further drawings. To remove the effect of these presets affecting 
an object representation, use the A > preset > default menu cascade reset parame-
ters. 
 
Note: to get back to the original opening view positionsimply type reset at the 
PyMOL> line command. 
 

22.. PPrreesseett  ooppttiioonnss::  eexxpplloorriinngg  mmoorree  
 

✔✔ TASK-  Explore the other menus of this series.  
 
The cascade menu 2biw > A > preset is assumed in the following commands, just 
continue with the suggested command.  
 
For example, the first one the complete command would be 2biw > A > preset > 
simple 
 
 
simple 
 
Note: the protein backbone is shown as a line 
while the organic ligand is shown as sticks. 

 
 
 
ball and stick 

This is not very useful for a 
large protein such as this. 
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b factor putty 
 
The segments with the highest temperature factor 
are shown as thicker cylinders. Regions of better 
resolution have thinner diameter and are usually 
found at the core of the protein. Mostly loops in 
the outside of the protein wobble: the core por-
tions of the proteins usually appear more stable 
than the external loops. This is mostly useful for 
crystallographers but is a cool representation. 
 

 

 
 
 
 
technical 

 
Color domains in separate rainbow colors and shows 
backbone and side chains.  
Note that a subset name appears in the Names Panel 
(2biw_pol_co) that control the dashed-line hydrogen 
bonds. 
 

 
 
Pretty and publication create similar images of a 
rainbow color cartoon with a stick ligand.  
 
Pretty creates the default cartoon setting, while 
publication creates an image very similar to an 
image created by Molscript*. 
 
(* Per J. Kraulis 1991: MOLSCRIPT: A Program to Produce Both 
Detailed and Schematic Plots of Protein Structures. Journal of Ap-
plied Crystallography. 24: 946-950. hhttttpp::////wwwwww..aavvaattaarr..ssee//mmoollssccrriipptt//))  
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ligands 
 
This option will zoom in on the ligand site and 
show the protein as backbone except in the near 
vicinity of the ligand where side chains are 
shown. The ligand is depicted as a thicker cylin-
der. 
 
Note: to zoom out, simply click on the A in the 
ASHLC menu again. 

 
 
 
ligand sites 
 
There are a few options available in this sub-
menu, all pertinent to looking closely at the lig-
and in it’s binding pocket. 
 
You can explore a few of them on your own, once 
you are done then select the following option:  
preset > ligand sites > solid surface 
  

You should obtain a centered, zoomed view of the ligand shown as a stick model 
within a partial molecular surface pocket. The colors are the scheme of previously 
chosen colors, for example if you tried the “technical” preset earlier the coloring 
would likely be like a rainbow.  
 

✔✔ TASK This quick change will make a much nicer image:  
 

2biw > C > yellows > sand 
 
Now with the mouse click carefully anywhere on the ligand stick to select it. As 
before you will have a (sele) name within the Names Panel. You can now change 
the color with the following menu cascade: (sele) > C >  blues > slate 
 
Of course you can pick your own colors. Make sure that there is sufficient contrast 
between the color of the surface and the color of the ligand. 
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If you have not yet done so, rotate the 
molecule to select a nice viewing an-
gle. 
 
If you want to add a more stunning 
effect click on the “ray” button as we 
did before to complete your publica-
tion quality picture. 
  
 
 
 
 
Note: If you are preparing a figure for 
a black and white print publication, it 
might be advantageous to use the var-
ious gray scales, black, and white 
within the “grays” option under the C 
menu in the “Names Panel.” 
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Clipping plane & Surface 
11.. CClliippppiinngg  ppllaanneess::  nneeaarr  aanndd  ffaarr    
 
Clipping planes are imaginary planes in the front and back of the molecule. Parts 
of the molecule that are outside the planes are “clipped” and therefore invisible. 
This is very useful for complex or large structures. 
 
 
This image represents the molecule seen 
side-ways “inside” the computer moni-
tor.  
 
The 2 black lines represent the yon (far) 
and hither (near) clipping planes. These 
are parallel to the flat screen of the 
computer monitor display. The gray 
lines converge toward the user’s eye 
who is looking at the molecule on the 
computer screen. 

 
                                           hither       yon 

          (near)       (far) 

✔✔ TASK 
 
The DMC computers are equipped with 3-button mice. To move clipping planes 
press shift and the right mouse button simultaneously while dragging up and 
down. The same result can be obtained by using the middle button scroll wheel. 
 
As an exercise, try to remove some of the molecular surface covering the ligand 
to create a picture similar to this: 
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Note: we have seen previously that the top menu “Mouse” contains all the possible 
options, with a reminder displayed at the bottom right of the PyMOL window. The 
method to adjust the clipping plane will depend on the number of buttons on your 
mouse. Use the “Mouse” menu to adapt to your mouse on your own system. 
 
Regardless of the number of buttons on your mouse, simply look at the bottom right to see 
the corresponding mouse + keyboard action for the following 2 items: MovZ and Clip. 
 
MovZ will move the object closer or further from your point of view.  
 
Clip will reduce the size of the box into which the object is represented and increase the 
contrast with depth-cueing, making parts of the molecule that are further back much dark-
er. 
 
Playing with these 2 items, it is possible to increase the feeling of depth and 3D feeling of 
any represented object and particularly surfaces with deep pockets. 
 
You need to make sure however that the “depth-cue” option is engaged within the menu 
“Display.” 
 

✔✔ INFO Alternatively: the clip command can be used with the line-
command, as shown in these examples6: 
 
clip near, -5  # moves near plane away from you by 5 Å 
clip far, 10  # moves far plane towards you by 10 Å 
clip move, -5  # moves the slab away from you by 5 Å 
clip slab, 20  # sets slab thickness to 20 Å 
clip slab, 10, resi 11 # clip 10 Å slab about residue 11 
clip atoms, 5, pept # clip atoms in "pept" with a 5 Å buffer 
                        # about their current camera positions 
 
 
 
                                                
6 http://philgrid.asti.dost.gov.ph/index.php/PyMOL#Control_of_clipping_planes   [ 
http://bit.ly/O4ckco ] 
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22.. SSoolliidd,,  cclliippppeedd  iinntteerriioorr  ssuurrffaaccee  
 
IMPORTANT NOTE: the presets can alter default behavior of PyMOL in a way 
that cannot be (or not easily undone.) Therefore we need to quit, restart and reload 
the structure. 
 

✔ TASK: Quit and restart PyMOL 
 
- Import the 3D data again, type:   fetch 2biw, type=pdb2 
- Color everything gray   Display > C > grays > gray70 
or use the typed command:    color gray70  
- Make background white (top menu):  Display > Background > White 
or use the typed command:    bg_color white 
- Hide the water molecules (mouse): 2biw > H > waters 
or use the typed command:    hide nonbonded 
- Show as surface:    2biw > S > surface 
or use the typed command:    show surface 
- Show ligand as stick   2biw > S > organic > stick 
or use the typed command:    show sticks, organic 
- Show iron as sphere, type:  show sphere, element fe 
- Show 2 waters sphere, type:  show sphere, resi 2022+2079 
- (re)color all waters red:   color red, resn HOH 
 
Now we need to set some parameters that will make the surface look solid by typing the fol-
lowing commands: 

unset depth_cue 
unset ray_shadows 
set ray_interior_color, gray80 
set opaque_background 

 
Now the tricky part will be to rotate the molecule in such a way as to see the interi-
or pocket without clipping the ligand. The 2 waters will most likely be clipped. 
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NOTE: if part of the back surface appears 
black, it means that the far clip plane is too 
close and need to be placed further. Likely 
the following command will do the trick, 
placing the far clipping plane 30 Å further 
away: 
 
 clip far, -30 
 
We can set the ray trace mode with black 
highlights: 
 
 set ray_trace_mode, 1 
 
Finally, render the image by pressing the 
“Ray” button or typing the command ray. 
 

 

 
 

✔✔ INFO  - Pressing the button “Get View” in the upper right will provide a 
complex matrix of numbers which, when pasted or copied into PyMOL will give 
the exact orientation presented above: 
 
set_view (\ 
     0.289975971,   -0.916524768,   -0.275475979,\ 
     0.937972188,    0.329330176,   -0.108357012,\ 
     0.190034315,   -0.226969540,    0.955183089,\ 
    -0.000179246,    0.000244899, -204.606140137,\ 
    29.327486038,    4.797065735,   31.367763519,\ 
   195.712844849,  242.537857056,  -20.000000000 ) 
### cut above here and paste into script ### 
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Distances & Labels 
11.. DDiissttaanncceess::  tthhee  MMeeaassuurreemmeenntt  WWiizzaarrdd..  
 
(Continues from the previous exercise.)  
 
Distances are measured between two atoms and are expressed in the same unit as 
the XYZ coordinates within the PDB file: Angstroms (1Å = 10–10 m). 
 
As an example we shall measure the distance between two atoms within the carot-
enoid ligand. 
 
Within the top menu select  
Wizard > Measurement  
(Note: in older PyMOL versions Measurement was called Distance.) 
This will create a prompt within the Viewer:  
“ Please click on the first atom…” 

 
 

 
Within the “Internal GUI” a “Measurement” table 
also appears. It can also be used to remove meas-
urement objects after they are no longer needed. 

 
 
Click on the first atom on the ligand 
Click on the second atom on the ligand 
 
(you can select the same atoms as in the exam-
ples within the image at right, or select your 
choice of atoms) 
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The default color of the measurement object is yel-
low. This can be easily changed with the familiar 
ASHLC menu for each measurement, as a new 
name is entered within the “Names Panel” for each 
distance, e.g. “measure01.” 
Change the color to white with the following menu 
cascade: measure01 >  C > grays > white 

 

 
When you are done using the “Measurement” panel on the bottom right click Done.  
If you no longer need to display the distance object, click Delete All Measurements. 
Alternatively you can use the corresponding “A” menu and choose “delete”. 
 

✔✔ INFO  - Distances are labels  
The display of a distance measurement is a label. To alter the number of decimal 
digits reported change the label setting label_digits from default 1 to the desired 
value with either the Setting > Edit All… menu cascade or the line command:  
set label_digits, 2 
 
 

22.. PPyyMMOOLL  LLaabbeellss  

22..11 LLaabbeell  wwiizzaarrdd  
 
The menu Wizard > Label can label an amino ac-
id residue by simply clicking. The label choice is 
by default set on residue name and its number 
(resn-resi) but can be modified by clicking the 
“Mode” button within the open Wizard menu at 
bottom right.  
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To label a residue simply click on one of its atoms. 

22..22 LLaabbeellss  
 

 ✔ TASK: Click on TYR 322 to have it within the (sele) name. 
 
Alternatively use the command-line to create a selection entry: 
 
select TYR322, resi 322 
show sticks, TYR322 
 
A label containing the residue type and sequence number (e.g. TYR 322) can be 
added to a selected residue with the mouse-driven menu cascade:  

(sele) > L > residues 
If you have used the line command option the menu would be:  

TYR322 > L > residues 
 
By default, labels are created the same color as the atom and placed at the C-alpha 
carbon position. The next 2 sections will show how to move the label and how to 
change its color. 

22..33 MMoovviinngg  llaabbeellss  wwiitthh  mmoouussee  
 
The default position of the label may not be ideal and it would be nice to move it. 
This can be done with the “mouse editing” mode that can be selected from the 
Mouse top menu or by line-command. The Mouse menu works regardless of the 
number of buttons that are actually on the mouse - therefore this works also for 
laptops with a track-pad. The menus could be 
 
Mouse > 3 Button Editing 
Mouse > 2 Button Editing 
 
The line command is simply:  edit_mode 
 
When in edit mode, simply click on the “control” button to click and move the la-
bel. 
 
TO make it easier to move the label and to see it, we can start by making it a bigger 
size with the line command: 
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set label_size, 40 

 
Then using the CRTL key move the label from its default position to a new posi-
tion: 
 

  
Before After 

 
Return to mouse viewing with menu: Mouse > 3 Button Viewing 

22..44 LLaabbeell  ccoolloorr  
 
Q: “How can I change only the label color without changing the display of the atom 
or molecule? “ 
 
A: You can change the label color to e.g. yellow with the following line command:  
set label_color, yellow, sele 

 
• yyeellllooww can be changed for other colors (The C menu can be a source of in-
spiration for colors and color names.) 
• sseellee represents the current selection. You can alter the command with the 
name of the object you are working on e.g. 2biw 
• note the use of the comma (,) within the line command 

 
For publications or slide making, labels could be added with e.g. Adobe 
(PhotoShop, Illustrator) or Microsoft (PowerPoint) graphic editing software. 
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✔✔ TASK 
 
Explore the L menu, knowing that “clear” will 
remove the mess that may occur! 
 
(on this image colors were inverted for easier 
reading.) 

 
 

22..55 GGeenneerraall  llaabbeell  SSeettttiinnggss  
 
General default settings can also be altered generally:  
 

✔✔ TASK 
 
Open the Setting > Edit All… top menu and change settings as illustrated 
 
Default label values Label values changed  
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22..66 LLaabbeelliinngg  oonnee  aattoomm  
 
Text label can also be added within PyMOL, although as suggested above, adding 
label within a graphical software might be more appropriate in some cases. 
 

✔✔ TASK 
Change the mouse selection to Atoms  
 

 

 

Click on one atom within the carotenoid 
 

Pink squares appear. 

Within the text entry box type the following command: 
 
label sele, “Ligand” 
 
Note: the word in quotes, here “ligand” can be changed 
to any other word, such as “my molecule” or “carote-
noid” etc. 
 

 

 

To clear the label, simply type: label sele 
 

✔✔ TASK   
 
Switch the selection mode back to residues 
 

 

 

22..77 GGrreeeekk  aallpphhaabbeett  ((OOPPTTIIOONNAALL  IINNFFOO))  
 
Letters from the Greek alphabet can be added to text-entered labels. The com-
mands call on special fonts called Unicode UTF8 fonts. The Greek font is #316, the 
alpha letter is number 261 and omega is 277 (268 and 269 are not used.) 
 
While alpha and beta might be most useful to label α-helices and β-sheets, the rest 
of the alphabet might be useful to label specialized items. 
 

✔✔ OPTIONAL   Label the atom with alpha and beta Greek letters and some 
text: 
Type the following commands within the text box: 
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label sele, "\316\261, \316\262: Greek Letters" 
<press enter> 
set label_size, 40 

 
 
Or write part of the alphabet: 
 
set label_size, 22 
label sele, "\316\261, \316\262, \316\263, \316\264, \316\265, \316\266, 
\316\267, \316\270, \316\271, \316\272, \316\273, \316\274, \316\275, 
\316\276, \316\277" 

 
 

22..88 MMoorree  iinnffoorrmmaattiioonn  
 
There is a lot more to labeling. Exhaustive information can be found at: 
 

http://wwww.pymolwiki.org/index.php/Label		  
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New objects & automatic 
zooming 
When we showed the surface (above exercise) with the menu cascade 2biw  > S > 
surface  you might have noticed that the carotenoid, organic compound was not 
shown as part of the surface, which is a useful feature in itself and is a default for 
all heteroatom entries within the 3D data (see previous section on PDB format.)7 
 
The question then arises: Q: “how can one make a surface of that compound?” 
The answer is to create a copy of these coordinates and change their type to ATOM 

11.. MMaakkiinngg  nneeww  oobbjjeeccttss  ffrroomm  sseelleeccttiioonn  
 
Any selection can be copied into an independent object with the “A” Actions: copy 
to object menu cascade. This will create a new entry within the “Names Panel” 
without the parentheses that becomes independent of the original PDB file. This is 
also true for the (sele) entry. 

11..11 CCrreeaattee  aa  nneeww  vveerrssiioonn  ooff  tthhee  lliiggaanndd  

✔✔ TASK  
- Click  on the background to clear the selection (sele) 
- Click  on the ligand ; (sele) now contains a copy. 

                                                
7 Surfaces are reserved for ATOM records only as. Typically ligands are stored as hetero-atom HE-
TATM records (but authors of the PDB file may choose otherwise, hence always check within the 
data!) 



 

68 MyMolecule 

  

- Click  on the A on the (sele)  line and choose: copy to object (a new entry 
called obj01 appears within Names Panel, and an automatic zooming oc-
curs) 

- Click  on the S on the (obj01) line to change the object appearance, e.g. as 
stick. 

 
Note: If you make obj01 invisible by clicking on the obj01 icon, the ligand is still 
visible because it is also part of the 2biw file! 
 
Note: If the option “extract object” was used instead, the ligand would have been 
removed from the 2biw object and would no longer be available under that name.  
 
Therefore the 2 options both create a new object, one makes a copy of the original, 
and the other moves it our of the original data. 
 

11..22 CChhaannggiinngg  aattoomm  ttyyppee  ffoorr  tthhee  lliiggaanndd;;  MMaakkee  ssuurrffaaccee  ffoorr  lliigg--

aanndd  
 
To change the atom type from HETATM to ATOM we can use the alter com-
mand on the new object: 
 

alter obj01, type="ATOM" 
 
Unfortunately, PyMOL somehow remembers that this is a ligand so one more step 
is necessary: as a “work around:” save the data in a file and re-open it: 
 

✔✔ TASK Assuming you have created obj01 
as described above and changed the atom type: 
 
 File > Save Molecule…. 

 

 
Click obj01 within the Save Molecule panel. 
 
Choose a file name and save the file e.g. 
lig.pdb.  
 
Save the file on the desktop or within the 
Home dir. 

 

 



Molecular Graphics with: PyMOL 69 

 

MyMolecule 69 

 

✔✔ TASK Open the PDB file lig.pdb with PyMOL: 
 
 File> Open… 
 
Alternatively type command: load 
~/Desktop/lig.pdb 
 
An entry “lig” now appears in the “Names Panel”  
 
Make a surface: 
 lig > S > surface 

 
 

  
ray-traced example 

 

22.. NNeeww  oobbjjeecctt::  ttuurrnniinngg  ooffff  aauuttoommaattiicc  zzoooomm  
 
When we created object obj01 the default action of 
PyMOL was to automatically zoom to the new object 
and reduce the clipping planes.  
 
That can be annoying in some cases, but could always 
be reversed with the line command “reset” or with 
the menu: 
  
Display > Clip > None or with the  
Display > Zoom menu options. 
 
This option is turned off by un-checking the menu 
item:  
 
Setting > Auto-Zoom New Objects 
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Displaying hydrogen 
bonds 
 

✔ INFO See also “Hydrogen bonds and Polar Contacts” within the following 
web page: 
 https://pymolwiki.org/index.php/Displaying_Biochemical_Properties 
[or  http://bit.ly/MF3OwT ] [archived: http://bit.ly/2xiI9gr] 
 
 

✔✔ TASK We will display a short helical fragment from 2biw and show H-
bonds 
 
Getting prepared: 
 
- The 2biw file should be loaded from the previous exercise. If not use the fetch 
command to import it as in the first exercise. 
- Within the Names panel: 2biw > H > everything 
  
The following is an example to display the hydrogen bonds within the alpha helix 
consisting of residues 94 to 105 in 2biw: 

 
- First create object “helix-1” containing the amino acid residues range forming the 
helix by typing the following line within the line-command area: 

 
select helix-1, resi 94-105 

 
- Display the selection (use mouse in “Names Panel”): (helix-1) > S > sticks 
- Add a display of the cartoon:       (helix-1) > S > cartoon 
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- For easier rotation type the line-command:      center helix-1  
- Then find the polar contact the menu cascade using the mouse in “Names Panel:” 

 
(helix-1) > A > find > polar contacts > within selection 

 
A new objects  
helix-1_polar_conts is 
created.  
 
The yellow default color for 
the dashed line is easily 
changed with the C menu for 
this object.  
 
For example a darker color 
can be chosen for display 
against a white background.   
 
Note: choosing  the submenu “to other atoms in object” would show additional 
hydrogen bonds of the helix side-chains to other parts of the protein. 
 
Note: for more complex issues regarding hydrogen bonds or adding hydrogen at-
oms refer to the web link listed above. 
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Electrostatic potential 
 

✔✔ Advanced: Alternate methods and resources not covered in this tutorial: 
The most accurate potential maps can be calculated by external software (Grasp, 
Delphi, APBS, MEAD)  and displayed in PyMOL.  A tutorial example for APBS is 
available online (see section 3.2. PyMOL) at  
http://ibibmem.uchicago.edu/roll-documentation/apbs/tutorial/index.html 
Archived at: http://bit.ly/1Bpc1y8 
 
New home page for APBS and PDB2PQR: 
https://sites.google.com/a/poissonboltzmann.org/software/home  
Or http://bit.ly/2c9f4HQ archived (9/8/2016): http://bit.ly/2cdDf8J 

✔✔ READ  PyMOL offers an approximate map nicknamed "charge-smoothed" sur-
face representing approximate charge distribution on the protein surface.  
Assuming that you have 
PDB data 2BIW, the po-
tential surface is calculat-
ed and displayed with the 
following menu cascade 
on the Names Panel:  

11.. CCaallccuullaattiinngg  aanndd  ddiissppllaayyiinngg  aa  mmaapp  
✔✔ TASK Reopen the saved session in the previous exercise or start with a 
new PyMOL session and input the 2BIW data (type=pdb2) as previously. 
 
Generate an electrostatic potential map display with the following mouse menu 
cascade: 
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2biw > A >  generate > vacuum electrostatics > protein contact potential (local) 
 

 
 
 
The process creates 3 
new entries within the 
Names Panel: 
 
2biw_e_chg 
2biw _e_map, and 
2biw_e_pot  
 
 

 
 
 
2biw_e_chg is an object containing the surface, colored red/white/blue and 
is an approximate map.  

 
2biw_e_map is usually not shown (click on name to show) and displays the 
volume boundaries as e.g. a big cube. 
 
2biw_e_pot is the object representing the color ramp and value at the bot-
tom of the display. 

22.. AAddjjuussttiinngg  ccoolloorr  lleevveellss  wwiitthh  tthhee  mmoouussee  
 

With protein 2BIW the default values for red and blue are -55.248 and +55.248 re-
spectively. 
 
It is possible to adjust the color level with the middle button and the control key. 
 

✔ TASK 
- Place the mouse over the color scale 
- Hold the CTRL key and click on the middle button. 
- Adjust the color level by sliding the middle button 
- Go first to a range near +/- 100 
- Then to a range near +/- 10 
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Note: Do not go all the way to -0 +0 as it then becomes virtually im-
possible to slide to proper values after that. 

 

  
 

33.. AAddjjuussttiinngg  rraannggee  wwiitthh  lliinnee  ccoommmmaanndd  
 
If two proteins are present, the process has to be applied to each individual protein, 
and the same _e_ objects are created for each one. The values within the 
2biw_e_pot color ramp may be different for each protein. Therefore it is useful to 
know how to change the values within. Smaller numbers will increase the blue and 
red strength and contrast within the blend of white surface, while larger numbers 
will dim the colors.  
 

 ✔✔ TASK 
 
To change the color range within the ramp:  
(example): ramp_new  2biw_e_pot , 2biw_e_map, [-100,0,100] 

44.. AAddjjuussttiinngg  tthhee  ddiissppllaayy  ccoolloorrss  
 
The default colors are red/white/blue, hence the above command could also be 
rewritten to change ramp values and specify colors: 
 
ramp_new 2biw_e_pot , 2biw_e_map, [-100,0,100] , [ red, white, blue] 
or 
ramp_new 2biw_e_pot , 2biw_e_map, [-100,0,100] , [ [1,0,0], [1,1,1] , [0,0,1] ] 
 
where [ [1,0,0], [1,1,1] , [0,0,1] ] represents the [R, G, B] 
(red/green/blue channels) values for each of the 3 displayed colors. To change the 
displayed color, simply change the definition of the colors. For example, the values 
[ [1,1,0], [1,1,1], [0,1,1] ] would create a ramp as 
yellow/white/cyan. 
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✔✔ INFO 
 
An alphabetical list of all 
PyMOL-defined color names 
can be found under the top 
menu “Setting > Colors…” 
 
Within that window the col-
ors can also be edited.  
 

 

 
The C menu within the 
Names Panel offers a list of 
color names grouped by tint. 
 
The name of the tint/color is 
shown in its own hue. 

 
 

55.. DDeeffaauulltt  ddiissppllaayy  
 
Note that when the calculation first takes place, the surface is shown but the 
original PDB file is hidden. In the case of 2BIW it means that the carotenoid 
becomes invisible. To restore it, simply click on button 2biw within the 
Names Panel: this will restore the display of the protein and ligand as lines 
or sticks. Since the protein is under the surface it will remain invisible (but 
some odd side chains might stick out of the surfaces.) To make more com-
plex images it may be useful to create a new object containing the ligand 
alone (see creating objects below.) 
 

66.. DDeelleettiinngg  ccaallccuullaatteedd  mmaappss  
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2biw_e_chg, 2biw_e_map, and 2biw_e_pot are PyMOL objects that can be deleted 
with the A (action) button. Note: the menu will be different for the 3 objects within 
the A menu! 

 

✔✔ TASK Delete the 3 objects pertinent to the electrostatic potential : 
 
2biw_e_chg > A > de-
lete 

2biw_e_map > A > de-
lete  

2biw_e_pot > A > delete  
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Side chain mutations 
Wizard 
 
PDB files show the structure of a particular sequence and conformation. However 
sometimes it is useful to mutate a side chain to see what the effect might be. 
 

11.. PPrreelliimmiinnaarryy::  ccrreeaattee  ssttaannddaarrdd  vviieeww  
 

✔✔ TASK 
 
- Follow the menu cascades: 
 
2biw > A > preset >ligand sites > 
transparent (better) 
 
This will create a similar view of the 
ligand within the pocket with some 
amino acid sides chains shown as 
sticks. 
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The default colors are rainbow. To 
make the display clearer, change the 
colors with the following cascade 
menus: 
 
- 2biw > C > blues > slate 
 
- Click on the ligand 
 
- (sele) > C > yellow 
  
 

22.. SSeelleecctt  ssiiddee  cchhaaiinn  ttoo  mmuuttaattee  
 
Since we already worked with Tyr 322 above, we shall use this as an example. 
 

✔✔ TASK 
- Rotate the view to find Tyr 322 
- Click within the blank area to un-select previous (sele) 
- Click on Tyr 322 with the mouse to select it 
- Change it to red: (sele) > C > reds > red 

 
 
 
(note that the surface associated with 
Tyr 322 will also change color.) 
 

 
 

33.. MMuuttaaggeenneessiiss  WWiizzaarrdd  
 
The menu cascade Wizard > Mutagenesis opens a new panel below the Names 
Panel and above the mouse control reminder. Directions will be prompted with 
text overlaid on the Viewer:  
 
“Pick a residue”  and   “Select a rotamer, or pick a new residue…” 
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✔✔ TASK 
 
Steps to mutate one amino acid side chain on a protein structure: 
 

- Open from the menu Wizard > Mutagenesis  
 

 
 
- When “Pick a residue” appears at top left, 
Click on Tyr 322 
 
(Note: if Tyr 322 is still selected in (sele it may 
be necessary to click twice. The first click will 
unselect Tyr 322, and the second will select it 
for mutation.) 

The text section will echo: 
 
  YYoouu  cclliicckkeedd  //22BBIIWW..ppddbb22////BB//TTYYRR`̀332222//CCGG  
  SSeelleeccttoorr::  sseelleeccttiioonn  ""sseellee""  ddeeffiinneedd  wwiitthh  00  aattoommss..  
  YYoouu  cclliicckkeedd  //22BBIIWW..ppddbb22////BB//TTYYRR`̀332222//CCGG  

  SSeelleeccttoorr::  sseelleeccttiioonn  ""sseellee""  ddeeffiinneedd  wwiitthh  1122  aattoommss..  
  MMuuttaaggeenneessiiss::  55  rroottaammeerrss  llooaaddeedd..  

 
A new copy of Tyr322 will be displayed in white and corresponds to an ideal rota-
tion. The default is that it is a backbone-dependent rotamer. 
 
Upon selection a slight de-zooming may occur. Zoom back closer with the right-
button mouse (Top > Down movement.) 
 

- When “Select a rotamer for TYR`322 or pick a new residue…” appears at 
the top left: Click on the white Tyr 322  
 
- Click on the No Mutation button and select a new amino acid: PHE 
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- Click the grey button Apply 
- Click the grey button Done 

 
Note: Clicking Done will exit the Mutagenesis Wizard. 
 

✔✔ TASK 
 
- Quit PyMOL 
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Automatic 3D Structure 
Superimposition 
 
The example will show how to superimpose 3 viral proteases in 3D: 

✔✔ INFO 
PDB ID TITLE 
1CQQ TYPE 2 RHINOVIRUS 3C PROTEASE WITH AG7088 INHIBITOR    
2HRV 2A CYSTEINE PROTEINASE FROM HUMAN RHINOVIRUS 2                  
1L1N POLIOVIRUS 3C PROTEINASE 
 

✔✔ TASK 
Preliminary:  

- Open a new PyMOL (MacPyMOL) session 
- fetch 3 PDB entries, for 2 of them we need to specify that we want only 
one of the biological units. Type the commands in the following order: 

  fetch 1CQQ 
  fetch 2HRV, type=pdb1 
  fetch 1L1N, type=pdb1 
  orient 
  reset 

-  remove waters with the mouse menu cascade: all > remove waters 
- Change background to white (Display > Background > White) 
- Hide everything and show ribbons: (Names Panel) 

all > H > everything 
all > S > ribbon 
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# If you want to add la-
bels: 
 
set label_color, black 
 
set label_size, 32 
 
set label_font_id, 7 
 
# select one atom 
# then label it: 
 
label sele, “1L1N” 
 
# repeat for the other 2 

 
 - We are now ready to attempt superimposition. 
 

11.. AAuuttoommaattiicc  ssuuppeerriimmppoossiittiioonn::  AAccttiioonn  mmeennuu  
 

✔✔ TASK 
 
To align all of the objects to 1CQQ, use the following menu cascade: 
 

1CQQ > A > align > all to this 
 

 
 
With the automatic superimposition the 3C proteases are best matched together 
while the 2HRV 2A proteinase does not match as well. 

✔✔ TASK Repeat the process this time selecting 2HRV as the reference: 
 
2HRV  > A > align > all to this 
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Is the alignment better, worse or of similar quality?:________________________ 
 

✔✔ TASK 
 
Repeat again the process 
this time selecting 1L1N as 
the reference: 
 
1L1N > A > align > all to 
this 
 

 
 
This third attempt aligning all to 1L1L provides the best overall result. 

22.. GGrriidd  vviieeww  
 
This is the perfect opportunity to introduce the grid view option where each mole-
cule is given a portion of the viewer screen. It is engaged with the line command: 
 
set grid_mode,1 
 
Depending on the size or resizing of the PyMOL window the 3 molecules will oc-
cupy a 1/4 portion of the screen if the window is roughly square, but will occupy 
1/3 of the viewer if the window is stretched: 
 

 
 
Molecules will move all at the same time when the mouse is moved. 
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To return to the normal view simply issue the command:  set grid_mode,0 
 

33.. PPaaiirrwwiissee  ssuuppeerriimmppoossiittiioonn  
 

PyMOL will have no problem aligning 2 similar structures. PyMOL firsts 
creates a sequence alignment then tries to align the structures accordingly.  
 

• mouse method 
 
The action selected just above (A > align > all to this) aligns all other mole-
cules to the chosen reference. However, each molecule can also be matched 
to any specified other molecule. 
 
For example, click on the Action button 
of 2HRV and follow the cascade: 
 
 
2HRV > A > align > to molecule > 1L1N 

 

 
• line command method 

 
If 2 proteins are named struct1 and struct2 within the Names Panel, the 
simple line command will align them:  align struct1, struct2  
(note the use of the comma after struct1) 

      Example: align 2BIW, 2BIX 
 
 

✔✔ Advanced: Alternate methods and resources not covered in this tutorial: 
 
For more complex alignment questions, see the following web site: 

http://pldserver1.biochem.queensu.ca/~rlc/work/teaching/BCHM8
23/pymol/alignment/ [archived: http://bit.ly/2c2YIEx ] 

See Pymol commands: 
 • Align: http://pymolwiki.org/index.php/Align 
 • Fit:   http://pymolwiki.org/index.php/Fit 
See Pymol extensions: 
 • Cealign: a structure-based alignment (not sequence –based) 
   http://pymolwiki.org/index.php/Cealign 
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Model building: 
modelling a helix 
 

✔✔ READ PyMOL offers modeling options for small molecules and proteins. 
For example you can build an alpha helix from scratch with a specific sequence.  
 
The “builder” interface to accomplish this is different depending on the operating 
system.  
 
On Windows and X11 (Unix/Linux) versions of PyMOL, the “Upper Window” has 
an extra set of buttons to build by clicking on the various components to be assem-
bled such as amino acids.  
 
Windows builder interface: 
Small Chemical molecules builder panel: 

 
Protein builder panel: 
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The MacPyMOL version has the same capability but instead of clicking icons menu 
items are chosen as illustrated below. 
 
MacPyMOL builder interface:   is via the Build menus: 
Chemical molecules builder panel:

 

Protein builder panel: 

 
 

✔✔ INFO 
MacPyMOL is a hybrid version that also contains the X11 version. To access the 
X11 version simply copy and rename the MacPyMOL application (e.g. on the 
Desktop) with the menu cascade:  
 

- Click once on MacPyMOL  
- use the Finder menu: Edit > Copy  
- Click anywhere on the Desktop , then Edit > Paste 
- Change the name from “MacPyMOL Copy” to “PyMOLX11Hybrid” 
- The change of name will activate the X11 version embedded within upon 
double clicking 

 
Note: X11 has to be installed on the Macintosh for this to work. Current ver-
sions of the Mac OS install X11 by default. 
Note: an Xterm terminal will appear  
 
The X11 version looks very similar to the Windows version, including a split 
between the upper and lower windows. 
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X11 builder interface:  
 
Small Chemical molecules builder panel: 
 

 
 
Protein builder panel: 
 

 
 
 

 

11.. SStteeppss  ttoo  bbuuiilldd  aa  ppoollyy--AALLAA  mmooddeell  hheelliixx  

11..11 MMaacciinnttoosshh  MMaaccPPyyMMOOLL::  
 
follow the menu cascades: 
- Build > Residue > Helix 
- Build > Residue > Alanine 
- Repeat another 11 times for a total 
of 12 residues 

 
- Alternatively use the Option+A keyboard shortcut  
- The model will be built within the Viewer and have name “ala” within the Names 
Panel. 
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Note: the C carbon to which the next amino-acid is attached is shown by a spheri-
cal symbol. 

11..22 WWiinnddoowwss  //  XX1111::  
 
- Click on “Builder” button (far right)  
- Click on “Protein” button (far left) 
- Change the default parallel-beta sheet to helix: bottom of menu: Click “next” 
twice  
 

 
 
- Click on Ala 12 times 
- The model will be built within the Viewer and have name “ala” within the Names 
Panel. 

11..33 SSaavvee  tthhee  mmoolleeccuullee  iinnttoo  aa  ffiillee::  
 
- menu File > Save Molecule .  
- verify that “ala” is selected, or click on ala. 
- Click OK 
- The default name is the name of the first amino acid used e.g. ala.pdb 
 
 
The alpha helix is created as a “per-
fect” model and contains all hydro-
gen atoms.   
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Class notes 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 http://www.gutenberg.org/files/24518/24518-h/images/image49.png 
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